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У даній роботі розглядається процес розробки електронного пристрою 

від аналізу технічного завдання удосконалення та покращення. Основна 

частина включає в себе детальний аналіз технічного завдання та структурної 

схеми виробу, опис принципу роботи електричної принципової схеми, її 

проектування і розрахунок окремих вузлів, а також вибір і обґрунтування 

компонентної бази. Проводиться компоновка друкованого вузла пристрою та 

оцінка його собівартості. 

Спеціальна частина присвячена обґрунтуванню вибору систем 

автоматизованого проектування (САПР) для розробки та опису процесу 

створення 3D-моделі плати виробу. 

Останній розділ містить питання охорони праці та безпеки 

життєдіяльності при роботі з розробленим пристроєм. 

 

 

 

 

 

 

 

 



ANNOTATION 

 

Zemledukh V.A. "Development of the design of a two-channel thermometer-

thermostat on the AT89S2051 microcontroller." Bachelor's thesis, Ternopil National 

Technical University named after Ivan Pulyu, faculty of applied information 

technologies and electrical engineering, group RAs-41. //Ternopil, 2024.// p.-60, 

fig.-27, bibliography,-29, add.-7. 

Keywords: THERMOMETER, TEMPERATURE, WORKING MODE, 

THERMOSTAT, TEMPERATURE MODE. 

This work considers the process of developing an electronic device from the 

analysis of the technical task of improvement and improvement. The main part 

includes a detailed analysis of the technical task and structural diagram of the 

product, a description of the principle of operation of the electrical circuit diagram, 

its design and calculation of individual nodes, as well as the selection and 

justification of the component base. The layout of the printed unit of the device and 

the assessment of its cost price are carried out. 

A special part is dedicated to justifying the choice of computer-aided design 

(CAD) systems for the development and description of the process of creating a 3D 

model of a product board. 

The last section contains issues of labor protection and life safety when 

working with the developed device. 

 



Зміст 

Вступ……………………………………………………………………………...… 

1. Основна частина …………………………………..…........................................ 

1.1 Аналіз технічного завдання ……………………………………..……............. 

1.2 Аналіз структурної схеми виробу ………………………………..................... 

1.3 Опис принципу роботи схеми електричної принципової  та її аналіз……… 

1.4 Проектування і розрахунок вузлів електричної принципової схеми 

пристрою……………………………………………………………………….….. 

1.4.1 Розрахунок електричних параметрів окремих каскадів…………………... 

1.4.2 Розрахунок параметрів друкованого монтажу…………………………….. 

1.5 Вибір і обґрунтування компонентної бази…………………………………… 

1.6 Компоновка друкованого вузла пристрою…………………………............... 

1.7 Висновок до розділу 1........................................................................................ 

2. Спеціальна частина………..........................……………………….………… 

2.1 Обгрунтування використання та вибору САПР для проектування ………... 

2.2 Опис створення 3D  плати виробу...............  ………………………..…........ 

2.3 Висновок до розділу 2........................................................................................ 

3. Охорона праці та безпека життєдіяльності …….…........................................... 

3.1 Класифікація небезпек за джерелом походження  ………………………… 

3.2 Вплив вібрації на організм людини…………………………………………. 

3.3 Висновок до розділу 3........................................................................................ 

Висновки.................................................................................................................. 

Список використаних джерел................................................................................ 

Додатки…………………………………………………………………………....... 

 

 

 

 

 

 

ТНТУ, ФПТ, каф. РТ  
гр.РАс-41  м. Тернопіль 

Змн. Арк. № докум. Підпис Дата 

Арк. 

5 

ЗВА 3.22.056.001 ПЗ 

 
 
 

 

 

 Розроб. Земледух 
 Перевір. Химич 
 Рецензент  

  Н. Контр.  
 Затверд.  

Двоканальний термометр-
термостат на  мікроконтролері 

АТ89С2051 
Пояснювальна записка 

Літ. Аркушів 

 

 



 

 

 
Змн. Арк. № докум. Підпис Дата 

Арк. 

 ЗВА 3.22.056.001 ПЗ 
 
 

Вступ 

 

Актуальність роботи. Пристрій двоканальний-термометр термостат буде 

корисно для застосування в побуті, вдома, на дачі, лазні або погребі. З його 

допомогою можна проводити вимірювання температури навколишнього 

середовища, контролювати і регулювати робочу температуру електричних 

котлів, теплої підлоги, холодильних установок або морозильних камер. 

Для блоку вимірювання температури і управлінням нагрівачем був 

вибраний міконтроллер АТ89С2051-24РІ. Зважаючи на відсутність в ньому 

енергонезалежної пам'яті даних для зберігання відомостей про встановленому 

режимі і допустимих значеннях температури довелося застосувати окрему 

мікросхему з енергонезалежною пам'яттю АТ24С02-10РІ. Обидві мікросхеми 

розраховані на роботу в "індустріальному "інтервалі температур навколишнього 

середовища (-40 ... +85 ° С). На вибір вплинуло і те, що сумарна вартість цих 

мікросхем дуже не велика. 

Ступінь наукової розробки. Наукова новизна при проектуванні 

двоканального термометра термостата може включати кілька ключових 

аспектів, які покращують точність, надійність та функціональність пристрою. 

Один з таких аспектів полягає у використанні двох незалежних 

вимірювальних каналів для зменшення похибок і підвищення точності 

вимірювання температури. Це може включати впровадження нових 

алгоритмів обробки даних для синхронізації і порівняння результатів 

вимірювань з обох каналів. Крім того, важливою є висока точність та 

стабільність вимірювань, які можна досягти за допомогою високоточних 

датчиків температури, таких як платинові термометри опору (Pt100) або 

термопари типу K. Інтеграція автоматичних калібрувальних механізмів 

дозволяє зменшити похибки при тривалому використанні. 

Метою кваліфікаційної роботи є розробка креслень Е1, Е3, друкованої 

плати, складального креслення вузла приладу та опис його роботи, 

удосконалення схеми принципової. 
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Об'єкт двоканальний термометр термостат є складним вимірювальним і 

керуючим пристроєм, який використовується для точного вимірювання та 

підтримки заданої температури в різних системах і середовищах. 

Предмет є схема електрична принципова пристрою та опис схеми згідно 

завдання. 

Практичне значення одержаних результатів створення інноваційного 

та високоефективного двоканального термометра термостата з покращеними 

технічними характеристиками. 
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Розділ 1 Основна частина 

 

1.1  Аналіз технічного завдання 

Технічні характеристики приладу: 

1. Напруга живлення………….. ………………………………...….. ~9В; 

2. Габаритні розміри…………………….……………... 140×150 ×40 мм; 

3. Діапазон робочих температур…………………………...-50 до +950С;  

4. Струм споживання……………………………………………..…20мА; 

5. Відносна вологість……………………………....... від 10%… до 80%; 

6. Вага……………………………………………………..…………300г; 

7. Вимірювана температура, ° С. максимальна. +99,9 мінімальна. -55;  

8. Дискретність відліку, ° С …………………………………………..0,1; 

9. Підтримуюча температура, ° С…максимальна +99,9 мінімальна .0; 

10. Витрата часу на введення нового значення підтримуючої 

температури, С, не більше ……………………...........................…..….15; 

1.2 Аналіз структурної схеми виробу     

Схема складається з таких блоків: блока живлення +9В, випрамляча, 

стабілізатора на +5В, мікроконтроллера, датчика температури, 

енергонезалежної пам’яті, індикації та управління. 

 

Рисунок 1.1- Креслення схеми Е1 двоканального термометра-

термостата 
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1.3 Опис принципу роботи схеми електричної принципової  та її аналіз 

 

 

Рисунок 1.2  Креслення схеми Е3 двоканального термометра-

термостата 

Здатність навантаження виходів мікроконтролера варіюється: до 20 мА 

при низькому напрузі та 50 мкА при високому. Для економії виводів 

мікроконтролера обрано світлодіодні індикатори HG1 та HG2 зі спільними 

анодами. Щоб зменшити кількість виводів, програмно реалізовано динамічну 

індикацію з тривалістю відображення ряду 3 мс. Деякі елементи індикатора 

HG1.1 підключені замість інших, створюючи трьохрозрядну індикацію з циклом 

9 мс. 

Під час довгих операцій, таких як зчитування даних в EEPROM або 

визначення температури, динамічну індикацію можна призупинити, щоб 

уникнути мерехтіння. Програма оптимізована з урахуванням швидкості індикації 

для цього. 

Резистори R7-R14 обмежують струм катодів індикаторів, а транзистори 

VT1, VT2, VT4 комутують їх аноди, забезпечуючи послідовне підключення до 
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джерела живлення. Імпульсні перешкоди від датчиків ВК1 і ВК2 захищені 

резисторами R1, R2 та діодами VD5 і VD6. 

За допомогою оптимізації програми можливо використовувати один вивід 

мікроконтролера для зв'язку з датчиком і керування пам'яттю. Крім того, 

резистор R4 використовується для навантаження лінії інтерфейсу. 

Для забезпечення стабільного рівня логіки на вході мікроконтролера 

використовується резистор R3. Транзистор VT3 керує реле К1 та світлодіодом 

HL1. Діод VD10 захищає світлодіод HL1 від зворотної напруги. 

Світлодіод HL2 використовується як додатковий індикатор, підключений 

замість певних елементів HG2.2. Наприклад, він може використовуватися для 

відображення інформації про вимірювання датчика ВК2. 

Система живлення пристрою складається з випрямляча VD1-VD4 та 

стабілізатора напруги +5 В DA1. Датчики температури ВК1 і ВК2 - DS1820, 

кожен з яких має унікальний індивідуальний номер, збережений у внутрішньому 

ПЗУ. 

Це дозволяє з’днувати паралельно практично необмежене число датчиків 

, взаємодію з кожним з них окремо. У даному пристрої мікроконтролер подає 

датчикам першу команду предписушающую пропустити процедуру перевірки 

індивідуального номера . далі команда Convert_T ( 44Н ) запускає процес 

вимірювання температури відразу в двох датчиках. Через 750 мс , необхідних 

для завершення цього процесу , мікроконтролер подає команду Match ROM ( 

55Н ) , супроводжувану індівідуальним номером одного з датчиків. У результаті 

на наступну команду ReadScratehpad відкликається і повідомляє 

мікроконтроллеру результат вимірювання тільки цей датчик. Після цього 

послідовність команд Match RCM і Read S cratch pad повторяється для другого 

датчика. Полученні данні мікроконтроллер обробляє і виводить на індикатор . 

Для зручності незначущий нуль на індикатор не виводиться , а знак "мінус" , 

якщо він потрібний , примикає зліва до старшої значущою цифри.  
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Якщо при зв'язку з датчиком зафіксований збій , що може означати 

несправність або відсутність датчика, замість значення температури буде 

виведено ( в СТИЛІ -заклику вигляді) повідомлення " - dAt " . Короткотривалими 

натисканнями на кнопку SB1 перемикають прилад на індикацію показань 

датчика ВК1 або ВК2 . Якщо утримувати кнопку натиснутой більше 5 с, буде 

включений режим автоматичного почергового вивода показань датчиків з 

періодом 5 с.  

Виходять з цього режиму коротким на натисканням на ту ж кнопку . 

Терморегулятор завжди працює за показаннями датчика ВК2. Натисканнями на 

кнопку SB2 на індикатор визиваються значення температури в такій 

послідовності : нижня порогова ( при ній відбувається включення нагрівателя) - 

верхня порогова ( при її досягненні нагрівач буде виключений). Вивід на 

індикатор верхньої порогової температури супроводжується включенням 

світлодіода HL2 .  

Можна змінювати поточне значення порогової температури, виведене на 

індикатор, за допомогою кнопок SB1 (для збільшення) і SB3 (для зменшення). 

Крок зміни - 0,1 °C. Якщо утримувати відповідну кнопку натиснутою більше 1 с, 

значення почне збільшуватися або зменшуватися зі швидкістю 30 кроків у 

секунду. Якщо протягом 5 с жодна з кнопок не натискалась, прилад автоматично 

перейде до індикації поточної температури. Щоб вимкнути терморегулятор, 

досить встановити порогове значення температури рівним або меншим за 

верхнє. 

Перед початком вимірювання температури і її регулювання, пристрій 

повинен "зареєструвати" підключені до нього датчики - визначити і запам'ятати 

їх індивідуальні номери. Для реєстрації датчики підключають по черзі. 

Після увімкнення пристрою, натисніть на кнопку SB2 і утримуйте її не 

менше 5 с до появлення на індикаторі стилізованого повідомлення "Рг1", яке 

свідчить про готовність зареєструвати підключений датчик як ВК1. Якщо 

потрібно зареєструвати датчик як ВК2, коротко натисніть на кнопку SB2, що 

призведе до виведення на індикатор повідомлення "Рт2".  
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Ще одним натисканням можна повернутися на індикатор повідомлення 

"Рг1" і так далі. 

Фактична реєстрація відбувається після натискання на кнопку SB1. Якщо 

дев’ять спроб мікроконтроллера зв'язатися з датчиком і визначити його 

індивідуальний номер не вдається, буде виведено повідомлення про 

несправність або відсутність датчика, а на індикаторі з'явиться повідомлення "-

dAt". Після успішної реєстрації на індикаторі з'явиться значення вимірюваної 

температури, зареєстроване датчиком. Описану процедуру необхідно виконувати 

і у випадку заміни одного або обох датчиків. Інформація про датчики і режими 

індикації зберігається в мікросхемі енергозалежної пам'яті DS1[1]. 

 

1.4 Проектування і розрахунок вузлів електричної принципової схеми 

пристрою 

 

1.4.1 Розрахунок електричних параметрів окремих каскадів.  

 

Для  розрахунку  стабілізаторів  напруги  на  ІМС,  як  правило, 

необхідні  наступні  початкові  дані:  номінальне  значення  вихідної напруги  

UСТ ВИХ НОМ;  граничні  значення  вихідної  напруги  UСТ ВИХ min, UСТ ВИХ max; 

мінімальний і максимальний струми навантаження IН min, IН max;  температурна  

нестабільність  напруги  вхідної  α U ; нестабільність  вихідної  напруги  KНСТU   

або  коефіцієнт  пульсацій вихідної  напруги  KП ;  коефіцієнт  стабілізації  

напруги  KСТU ; внутрішній опір стабілізатора RСТ ВИХ ; температурний 

коефіцієнт γ  [2]. 

 

  

Рисунок 1.3– Електрична принципова схема стабілізатора і конденсатора  
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Вибір  ІМС  виконується  за  заданими  UСТ ВИХ,  IСТ ВИХ max,  KСТU , γ ,  

R СТ ВИХ із таблиці 1.1. Бажано віддавати перевагу тим ІМС, які працюють з 

меншою  кількістю  зовнішніх  елементів.  При  цьому  повинні виконуватися 

наступні умови 

ВИХCTВИХIMC UU   

maxmax НВИХIMC II   

CTUCTUIMC KK   

  

Рисунок 1.1 – Параметри стабілізаторів 

 

Було обрано стабілізатор 78L05, який має параметри такі як в  

KP142EH5A. 

Незалежно від типу обраної ІМС визначаємо наступні параметри 

 

                                          maxmin ВИХCTВХCT UU  + ПДCTU                                 (1.1) 
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ВU ВХCT 6,75,21,5min   




1

minВХCT

ВХCT

U
U            (1.2) 

ВU ВХCT 62,7
997,0

6,7

03,01

6,7



  

)1( )(max  ВХCTВХCT UU           (1.3) 

ВU ВХCT 65,803,162,7)03,01(62,7max   

де  α(+),  α(-)  –  найбільше  позитивне  та  негативне  відносне змінювання 

вхідної напруги. 

Можливі граничні значення ККД 

 

                                               
min

max

max

ВХCT

ВХCT

U

U
                                            (1.4) 

14,1
6,7

65,8
max   

                                               
max

min

min

ВХCT

ВХCT

U

U
                                            (1.5) 

89,0
65,8

6,7
max   

Передбачається,  що струм  споживаний  стабілізатором  є малим  

ВХCTВИХCT II  . 

Визначення ємності конденсатора за формулою: 

 

 
0

0

ÏrK

H
C               (1.6)  

де  С0 – ємність, мкФ; 

Коефіцієнт пульсацій Кп0=0,03  %; 

          r – опір, Ом. 

 

)(6,2166
03,010

65
0 мкФС 


  

Розраховуємо робочу напругу: 
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Рисунок 1.4 – Графік для визначення коефіцієнта Н: 

 

      (1.7) 

 

)(2,25184,1 ВU роб   

Вибираємо тип конденсатора з довідника за параметрами С0 ном і Uроб. 

Вибираємо  електролітичний конденсатор типу "ECAP" 25 V номінальною 

ємністю 2200 мкФ та  на робочу напругу 25 В [3]. 

 

1.4.2 Розрахунок параметрів друкованого монтажу 

 

          Визначаємо мінімальну ширину  друкованого провідника, мм., по 

постійному струму для кіл живлення і заземлення:           

               bmin1=
ti

I

доп *

max = мм

м
мм

A

A
2,0

035,0*48

02,0

2



               (1.8) 

 

де Іmax- допустима густина струму, який протікає в провідниках. 

Визначається із аналізу принципової схеми,  Імах = 20мА ; 

    Ідоп – допустима густина струму, вибирається в залежності від методу 

виготовлення плати, jдоп = 48А/мм2, t – товщина провідника, 35мкм=0,035м 

Визначаємо мінімальну ширину провідника, мм., виходячи з 

допустимого падіння напруги на ньому: 

 

xроб UU 22
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   bmin2=
t

lI

*  Uд

** max
= мм1,0

м035,0*В3,0

м3,0*A02,0*
м

мм.Ом
0175,0

2

=
                   (1.9) 

де р = 0,0175 Ом*мм2/м – питомий об’ємний опір, 

    L = 0,3м – довжина провідника, 

   допU  = 0,3В – допустиме падіння напруги. 

Визначаємо номінальне значення діаметрів монтажних отворів d: 

                                 d = dE + |∆dн.в.| + r                                                 (1.10) 

де dE – максимальний діаметр виводу встановленого ЕРЕ (діаметр 

вивода ЕРЕ.) 

     ∆dH.B. – нижнє граничне відхилення від номінального діаметру 

монтажного отвору (0,1 для всіх) 

r – різниця між мінімальним діаметром отвору і максимальним 

діаметром вивода ЕРЕ, її вибирають в межах 0,1…0,4мм. Розрахункові 

значення d зводяться до нормалізованого ряду отворів: 1,1; 1,3; 1,5 мм. 

dE1 = 0,7 для мікросхем DА1  та DD1, DS1 та також індикаторів. 

dE2 = 0,9 для  малопотужних резисторів, конденсаторів електролітичних і 

керамічних, діода VD1-VD7, та транзисторів VT1-VT4. 

dE3 = 1,3 для підпаювання провідників. 

 d = dE1 + |∆dн.в.| + r = 0,7 + |+0,1| + 0,4 = 1, 1 мм 

d = dE2 + |∆dн.в.| + r = 0,9 + |+0,1| + 0,4 = 1, 3 мм 

d = dE 3+ |∆dн.в.| + r = 1,3 + |+0,1| + 0,4 = 1,5 мм 

Приймаємо такі стандартні діаметри отворів 1,1;1,3; 1,5. 

Розраховуємо діаметр контактних площадок. 

 

                                             Dmin = D1min + 1,5hф            (1.11) 

де       hф – товщина фольги;   

D1min – мінімальний ефективний діаметр площадки.   

       







 pd

d
bD m 

2
2 max

min1                                (1.12) 
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де    bм – відстань від краю просвердленого отвору до краю контактної 

площадки. 

bм = 0,06 мм. 

 

де       δd  і δp - допуски на розташування отворів і контактних площадок; 

           δd =0,25мм, δp = 0,4мм; 

           dmax - максимальний діаметр просвердленого отвору, мм. 

 

dmax=d+∆d+(0,1…0,15) 

де        ∆d - допуск на отвір. 

dmax1 =1,1+0,1+0,1=1,3 мм 

dmax2 =1,3+0,1+0,1=1,5 мм 

dmax3 =1,5+0,1+0,1=1,7 мм 

ммD 72,24,025,0
2

3,1
06,021min1 








  

ммD 92,24,025,0
2

5,1
06,022min1 








  

ммD 12,34,025,0
2

7,1
06,023min1 








  

Dmin1=2,72+1,5·0,035+0,03=2,8мм 

Dmin2=2,92+1,5·0,035+0,03=3 мм 

Dmin3=3,12+1,5·0,035+0,03=3,2мм 

Максимальний діаметр контактної площадки: 

Dmax=Dmin+(0,02…0,06) 

Dmax1=2,8+0,02=2,82мм 

Dmax2=3 +0,02=3,02мм 

Dmax3=3,2+0,02=3,22мм 

Визначаємо ширину провідників. Мінімальна ширина провідників для 

ДДП і зовнішніх шарів БДП, які виготовлені комбінованим методом: 

                                  hфbb 5.1min1min                    (1.13) 
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      де      b1min  - мінімальна ефективна ширина провідника, мм.  

                b1min =0,15 мм для плат 4- го класу точності. 

ммb 2,0035,0*5.115,0min   

Визначаємо мінімальну відстань між елементами провідного матеріалу. 

Мінімальна відстань між провідником і контактною площадкою: 

 


























 1

22

maxmax

0min1 
d

p
D

LS                          (1.14)                  

ммS 01,005,0
2

3,1
4,0

2
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5,21min1 
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



















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                     
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5,22min1 
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
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











  

1min 2

3,22 1,7
2,5 0,4 0,05 0,41

2 2
S мм

    
          

      

де       Lo – відстань між центрами відповідних елементів; 

Мінімальна  відстань між двома контактними площадками: 

                S2min = L0 – (Dmax + 2δp)           (1.15) 

S2min1 =2,5-(2,82+2·0,4)=-1,1мм 

S2min2 =2,5-(3,02+2·0,4)=-1,3мм 

S2min2 =2,5-(3,22+2·0,4)=-1,5мм 

Мінімальна відстань між двома провідниками: 

         S3min=L0–(Dmax+2δ1)        (1.16) 

         S3min1 =2,5-(2,82+2·0,05)=-0,42мм 

         S3min2 =2,5-(3,02+2·0,05)=-0,62мм 

         S3min2 =2,5-(3,22+2·0,05)=-0,82мм 

 

1.5  Вибір і обґрунтування компонентної бази 

Конденсатор ECAP 2200мкФ - 25В - це електролітичний конденсатор з 

великою ємністю та невисоким робочим напругою. Основна характеристика 

цього конденсатора - його ємність, яка становить 2200 мікрофарад (мкФ), що 

вказує на його здатність накопичувати електричний заряд. Робоча напруга 25 
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вольт (В) визначає максимальну напругу, яку може витримати конденсатор без 

пошкодження або витікання. 

Особливості конденсатора ECAP 2200мкФ - 25В: 

Велика ємність: Ємність 2200 мкФ дозволяє конденсатору зберігати 

значну кількість електричного заряду. 

Низька робоча напруга: Робоча напруга 25В вказує на те, що цей 

конденсатор підходить для застосувань, де потрібна помірна напруга. 

Електролітичний тип: Це електролітичний конденсатор, що означає 

використання електроліту як діелектрика, що забезпечує високу ємність при 

відносно невеликих розмірах. 

Полярність: Електролітичні конденсатори мають полярність, тобто вони 

мають позначення "позитивний" та "негативний" полюси, яке необхідно 

дотримуватися при підключенні до схеми. 

Використання: Конденсатори з подібними характеристиками часто 

використовуються в електронних схемах для фільтрації струму, стабілізації 

напруги та для зберігання енергії. 

Важливо правильно добирати конденсатори для конкретних застосувань, 

забезпечуючи відповідність їх характеристик потребам схеми.  

 

Рисунок 1.5- Габаритні розміри конденсатора типу ECAP 2200mF-25V 

 

Конденсатор B37979 - 0.47мкФ 5% "Epcos" - це керамічний конденсатор 

від компанії Epcos. Він має наступні характеристики: 

Тип конденсатора: Керамічний. Це означає, що його діелектрик 

складається з керамічного матеріалу, що забезпечує невеликі розміри, високу 

швидкість реакції та стабільність роботи на високих частотах. 
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Ємність: 0.47 мікрофарад (мкФ). Це вказує на здатність конденсатора 

зберігати електричний заряд. 

Точність: ±5%. Це визначає допустиму похибку у вимірах ємності 

конденсатора. У цьому випадку, значення ємності може відрізнятися на ±5% від 

зазначеної величини. 

Виробник: Epcos. Ця компанія відома своїми високоякісними 

компонентами для електроніки, і її конденсатори широко використовуються в 

різних пристроях та схемах. 

Застосування: Керамічні конденсатори, такі як цей, часто 

використовуються в електронних схемах для фільтрації шуму, затухання 

перешкод, зберігання енергії та інших цілей. 

Завдяки своїм характеристикам та надійності, конденсатори Epcos є 

популярними серед інженерів та розробників електроніки. 

 

Рисунок 1.6- Габаритні розміри конденсатора B37979 - 0.47мкФ 5% 

"Epcos" 

 

Резистори позначені як "С2-33Н" відносяться до типу вуглецевих 

резисторів, що зазвичай використовуються в електронних схемах для обмеження 

потоку електричного струму або для поділу напруги. 

Резистори серії С2-33Н є металлоплівковими резисторами з 

підвищеною стабільністю. Вони були розроблені для використання в 

радіоелектронній апаратурі, приладобудуванні, а також у високочастотних 

колах. Ось їх основні параметри: 
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1. Номінальна потужність розсіювання: 0.125 Вт (1/8 Вт). 

2. Номінальний опір: Від 1 Ом до 1 МОм. Конкретні значення 

можуть варіюватися в межах цієї області. 

3. Точність: ±1% (допуск опору). 

4. Температурний коефіцієнт опору (ТКО): В межах ±100ppm/°C 

(частки на мільйон на градус Цельсія). 

5. Робоча температура: Від -55°C до +155°C. 

6. Розміри: Залежно від номінального опору та потужності, розміри 

резисторів можуть дещо варіюватися. Зазвичай їхня довжина становить 

близько 6 мм, а діаметр - близько 2 мм. 

7. Напруга: Максимальна робоча напруга залежить від опору і 

потужності, зазвичай не перевищує 250 В. 

Ці резистори мають гарну стійкість до впливу вологості та механічних 

навантажень, що робить їх надійними для тривалого використання в різних 

умовах експлуатації. 

 

Рисинок 1.7- Габаритні розміри резисторів С2-33Н 

 

Світлодіод 5AW2UC виробництва Kento є діодним електронним 

пристроєм, який випромінює світло під впливом електричного струму. Ось 

основні характеристики цього світлодіода: 

Світлодіоди типу 5AW2UC виробництва Kento є високояскравими 

світлодіодами, які зазвичай використовуються в індикаторах, освітлювальних 

приладах та інших електронних пристроях. Ось основні параметри цього 

типу світлодіода: 

1. Тип світлодіода: 5 мм (T-1 3/4) стандартний корпус. 
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2. Колір випромінювання: Червоний. 

3. Яскравість: Зазвичай варіюється в межах від 5000 до 7000 мКд 

(мілікандел). 

4. Напруга живлення (Vf): Від 2.0 В до 2.4 В при прямому струмі. 

5. Прямий струм (If): Зазвичай 20 мА. 

6. Кут огляду: Близько 20-30 градусів. 

7. Довжина хвилі випромінювання: Близько 620-630 нм. 

8. Максимальний зворотний струм (Ir): Не більше 10 мкА при 

зворотній напрузі 5 В. 

9. Температурний діапазон роботи: Від -40°C до +85°C. 

Ці параметри забезпечують високу яскравість і надійність світлодіодів 

5AW2UC, що робить їх придатними для використання в різних електронних 

пристроях та системах індикації. 

 

Рисунок 1.8- Габаритні розміри світлодіода типу 5AW2UC виробництва 

Kento 

 

Індикатор типу HLEC-D512GWB - це світлодіодний дисплей, який може 

бути використаний для відображення різних інформаційних сигналів або 

статусів у пристроях та системах. Індикатор HLEC-D512GWB має високу 

яскравість, довговічність та надійність, що робить його популярним в багатьох 

галузях, де важливо якість індикації та енергоефективність. 

Ось основні параметри цього індикатора: 

1. Тип дисплея: 7-сегментний світлодіодний дисплей. 
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2. Кількість розрядів: 1 розряд. 

3. Колір випромінювання: Зелений. 

4. Розмір сегменту: 0.56 дюймів (14.2 мм). 

5. Напруга живлення (Vf): Близько 2.0-2.2 В на сегмент при 

прямому струмі. 

6. Прямий струм (If): Зазвичай 20 мА на сегмент. 

7. Яскравість: В залежності від конкретної моделі, зазвичай в межах 

кількох сотень мКд. 

8. Кут огляду: Близько 60-90 градусів. 

9. Полярність: Загальний катод або загальний анод (залежить від 

модифікації). 

10. Робочий температурний діапазон: Від -40°C до +85°C. 

Ці параметри забезпечують високу видимість і надійність індикатора 

HLEC-D512GWB, що робить його придатним для використання в різних 

електронних пристроях, таких як вимірювальні прилади, годинники, 

побутова електроніка тощо. 

 

 

Рисунок 1.9- Габаритні розміри індикатори типу HLEC-D512GWB 

 

Стабілізатор напруги 78L05 - це інтегральна схема фіксованої 

положитивної лінійної напругової стабілізації. Основним завданням цієї схеми є 

забезпечення сталої вихідної напруги незалежно від змін вхідної напруги та 

навантаження. 
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Основні параметри стабілізатора 78L05: 

Вихідна напруга: 5 вольт (це фіксована вихідна напруга для 78L05). 

Максимальний вихідний струм: Зазвичай близько 100 мА. 

Вхідна напруга: Звичайно від 7 до 20 вольт. Вхідна напруга повинна бути 

не менше вихідної напруги плюс певний допустимий резерв. 

Дроп-аут напруга: Це мінімальна різниця між вхідною та вихідною 

напругою для стабілізатора, при якій він забезпечує правильну роботу. Для 

78L05 ця величина становить приблизно 2 вольти. 

Стабілізатори серії 78XX мають три контакти: вхідний (VIN), вихідний 

(VOUT) і земля (GND). Вони зазвичай використовуються для живлення 

електронних пристроїв, які вимагають стабільної напруги. Ці стабілізатори дуже 

поширені і досить надійні у використанні. 

 

 

Рисунок 1.10 –Габаритні розміри стабілізатора 78L05 

 

Кварцевий генератор KX-26-11,0592МГц виготовляється компанією 

"Geyen Electronic" і призначений для генерації стабільного коливання на частоті 

11,0592 мегагерц (МГц). Основні характеристики цього генератора включають: 

Частота: 11,0592 МГц - це частота, на якій генерується коливання 

кварцевим резонатором. 

Стабільність: Генератор може мати високу стабільність частоти, що 

означає, що частота залишається майже постійною навіть при зміні температури, 

напруги живлення і інших умов. 
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Точність: Частота може відхилятися від заявленої значущої цифри 

(11,0592 МГц) лише на допустиму похибку, зазвичай вказану в специфікаціях 

виробника. 

Напруга живлення: Генератор може працювати при певному діапазоні 

напруги живлення, який зазвичай вказується у технічних характеристиках. 

Виходи: Генератор може мати один або кілька виходів, які зазвичай 

забезпечують прямокутні (цифрові) сигнали з визначеною амплітудою. 

Кварцеві генератори зазвичай використовуються в електронних 

пристроях як тактові джерела для синхронізації роботи мікроконтролерів, 

процесорів, логічних схем і т. д. їх висока стабільність і точність роблять їх 

популярними в додатках, де потрібен чіткий і точний хронометраж. 

 

 

Рисунок 1.11 –Габаритні розміри кварцового резонатора 4 МГц 

 

Мікросхема AT24C02-10PU - це EEPROM (електрично стирається 

програмована програмована запам'ятовуюча пристрій) від компанії Microchip 

Technology, що має двість кілобайтів пам'яті. Основні характеристики цієї 

мікросхеми включають: 

Об'єм пам'яті: Мікросхема має ємність 2 кілобайти, що означає, що вона 

може зберігати до 2048 байтів інформації. 

Інтерфейс зв'язку: Вона співпрацює з мікроконтролерами та іншими 

пристроями через простий інтерфейс зв'язку I2C (Inter-Integrated Circuit). Цей 

інтерфейс дозволяє передавати дані між мікросхемою та зовнішніми 

пристроями, використовуючи всього два проводи - лінії даних (SDA) та лінії 

клоку (SCL). 
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Швидкість передачі даних: Ця мікросхема підтримує стандартну 

швидкість передачі даних I2C, яка зазвичай становить до 100 кілобіт в секунду. 

Напруга живлення: Мікросхема працює в діапазоні напруги живлення від 

1,8 до 5,5 вольт, що дозволяє її використовувати з різними живленнями, 

включаючи батарейні джерела живлення. 

Стійкість до зберігання даних: Ця мікросхема має високу стійкість до 

зберігання даних, що означає, що вона може зберігати дані протягом довгих 

періодів без живлення. 

Стійкість до електричного видалення: EEPROM дозволяє записувати і 

стирати дані безперервно, не обмежуючи кількість циклів запису/стирання, але 

він має обмежену кількість циклів зберігання, після яких може зменшуватися 

стійкість даних. 

Робоча температура: Мікросхема працює в широкому діапазоні 

температур, зазвичай від -40°C до +85°C, що дозволяє її використовувати в 

різних умовах експлуатації. 

Мікросхема AT24C02-10PU часто використовується в електронних 

пристроях для зберігання конфігураційних даних, налаштувань та інших 

важливих інформаційних блоків, які мають бути збережені навіть при 

вимкненні живлення. 

 

Рисунок 1.12 –Габаритні розміри мікросхеми AT24СО2-10РІ 
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  Мікросхема AT89C2051 - це однокристальний мікроконтролер (МК), що 

розроблений компанією Atmel, яка входить у групу Microchip Technology. 

Основні характеристики цієї мікросхеми включають: 

Архітектура: Мікроконтролер має архітектуру з 8-бітним процесором, що 

базується на ядрі MCS-51 (Intel 8051-compatible). 

Об'єм пам'яті: AT89C2051 має вбудовану флеш-пам'ять об'ємом 2 

кілобайти, яка використовується для зберігання програмного коду і даних. 

Інтерфейси: Він має різні периферійні пристрої, такі як вбудований UART 

(універсальний асинхронний приймально-передавальний пристрій), 

таймери/лічильники і порти введення/виведення (GPIO), що дозволяє 

взаємодіяти зі зовнішніми пристроями. 

Робоча частота: Мікросхема може працювати на різних частотах, від 0 до 

24 мегагерц (МГц), зазвичай використовуючи кварцевий резонатор або 

внутрішній генератор тактових імпульсів. 

Напруга живлення: Напруга живлення для AT89C2051 зазвичай 

становить від 2,7 до 6 вольт, що робить його придатним для використання як з 

батарейними, так і з мережевими джерелами живлення. 

Інструкції: Мікросхема підтримує широкий набір інструкцій, які 

дозволяють програмістам створювати різноманітні програми для управління 

пристроями. 

Інтерфейс програмування: Його можна програмувати за допомогою 

стандартного програматора, такого як ISP (In-System Programming), який 

дозволяє записувати програмний код без вилучення мікросхеми з плати. 

Мікросхема AT89C2051 широко використовується в промислових та 

розважальних пристроях, таких як промислові контролери, пристрої зв'язку, 

вбудовані системи керування, промислові автоматичні системи та інші пристрої, 

які потребують високої ефективності та надійності. 
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Рисунок 1.13 –Габаритні розміри мікросхеми AT89C2051 

 

Діод 1N4148 - це швидкий кремнієвий діод, який використовується в 

електронних схемах для впорядкування електричних сигналів, захисту від 

зворотного напруги та інших застосувань. Ось деякі характеристики цього діода: 

Тип діода: 1N4148 - це однорідний діод, що має позначення у стандарті 

JEDEC. 

Технічні характеристики: 

Максимальна оборотна напруга (Reverse Voltage): 100 вольт. 

Максимальний прямий струм (Forward Current): 300 міліампер. 

Швидкодія (Switching Speed): Діод має дуже короткий час реакції, що 

дозволяє використовувати його в швидких схемах комутації. 

Температурний діапазон: Зазвичай працює від -65°C до +175°C, що 

робить його придатним для роботи в широкому діапазоні умов. 

Корпус: 1N4148 зазвичай має корпус типу DO-35, що дозволяє легко 

монтувати його на друкованій платі або в інших електронних пристроях. 

Застосування: Цей діод часто використовується в аналогових та цифрових 

схемах як діод клапана, випрямляч, захисний діод від оборотної напруги, 

індикаторний діод, а також в схемах комутації імпульсів. 

Надійність: 1N4148 є дуже поширеним і відомим діодом, відомим своєю 

надійністю і довговічністю. Цей діод широко використовується як у 

професійних, так і в любительських електронних схемах. 
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Рисунок 1.14- Зовнішній вигляд діода 1N4148 

 

Діодний міст KBP08 - це однопіввипрямний міст, який складається з 

чотирьох діодів, з'єднаних у мостову конфігурацію. надійним і ефективним 

компонентом для використання в різних електричних схемах, де потрібно 

випрямлення змінного струму на постійний та захист від оборотної напруги. 

Ось основні параметри діодного моста KBP08: 

Максимальна пряма напруга (Maximum Forward Voltage): Зазвичай 

становить близько 1.1 вольта при максимальному прямому струмі. 

Максимальний прямий струм (Maximum Forward Current): Максимальне 

значення струму, яке може пропускати діодний міст без пошкодження, зазвичай 

становить 1 або 2 ампера. 

Максимальна оборотна напруга (Maximum Reverse Voltage): 

Максимальна оборотна напруга, яку може витримати міст, зазвичай становить 

1000 вольт або більше. 

Максимальний оборотний струм (Maximum Reverse Current): Це 

максимальний струм, який може протікати через міст у заблокованому стані. 

Зазвичай він дуже малий, порядку декількох мікроампер. 

Температурний діапазон: Діодний міст зазвичай може працювати в 

діапазоні температур від -55°C до +150°C, що забезпечує стабільну роботу в 

різних умовах. 
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Рисунок 1.15- Габаритні розміри діодного моста KBP08 

 

DS18B20 - це цифровий термометр, який може бути програмовано для 

рівня точності від 9 до 12 біт. Отримані дані можуть зберігатися в EEPROM 

пам'яті пристрою. DS18B20 здійснює обмін даними через 1-Wire шину і може 

працювати як окремий пристрій на лінії або в групі. Управління всіма процесами 

на шині здійснюється центральним мікропроцесором. 

Він може вимірювати температуру в діапазоні від -55 °C до +125 °C з 

точністю 0,5 °C від -10 °C до +85 °C. Крім того, DS18B20 може живитися 

напругою лінії даних ("паразитне живлення"), якщо зовнішнє джерело живлення 

відсутнє. 

Кожен DS18B20 має унікальний 64-бітний послідовний код, що дозволяє 

спілкуватися з безліччю таких датчиків, які встановлені на одній шині. Це 

дозволяє використовувати один мікропроцесор для керування безліччю 

DS18B20, розташованих на значній відстані. Застосунки, які можуть 

скористатися цією особливістю, включають системи контролю температури в 

будівлях, обладнанні або машинах, а також контроль і керування 

температурними процесами. 
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Рисунок 1.16 Зовнішній вигляд датчика 

 

Транзистор BC557A - це PNP біполярний транзистор загального 

призначення. Він використовується переважно в аналогових та комутаційних 

схемах. Основні характеристики цього транзистора включають: 

Тип: PNP. 

Максимальна потужність колектора (Pc): Зазвичай близько 625 мВт. 

Максимальний струм колектора (Ic): До кількох сотень міліампер. 

Максимальна напруга колектор-емітер (Vce): Зазвичай близько 45 вольт. 

Коефіцієнт підсилення струму (hfe): Зазвичай в діапазоні від 110 до 800. 

Корпус: TO-92 або подібний. 

Діапазон температур: Зазвичай від -55°C до +150°C. 

Застосування: Від аналогових посилювачів до комутаційних схем, 

включаючи використання як ключі, буфери та підсилювачі. 

Транзистор BC557A широко використовується в електронних схемах як 

ключ або підсилювач, особливо в додатках, де потрібна здатність до комутації 

невеликих струмів. 

 

Рисунок 1.17 Зовнішній вигляд транзистора BC557A 
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Реле LEG-12 - це типове електромеханічне реле, яке використовується 

для керування електричними схемами за допомогою електричного сигналу. 

Основні характеристики цього реле включають: 

Кількість контактів: Зазвичай має 1 або 2 перемикаючих контакти. 

Тип контактів: Може бути один або два нормально відкритих (NO) або 

нормально закритих (NC) контакти. 

Напруга керування: 12 В або інша напруга в межах робочого діапазону. 

Максимальний струм комутації: Залежить від моделі, але в межах 10-20 

А. 

Корпус: металевий корпус з клемами для підключення. 

Застосування: Використовується для керування різними навантаженнями 

в електричних схемах, таких як освітлення, малопотужні двигуни, опалення 

тощо. 

Реле LEG-12 може використовуватися в різноманітних пристроях і 

системах, де потрібне періодичне включення або вимикання електричних 

навантажень за допомогою електричного сигналу від управляючого пристрою. 

 

Рисунок 1.18 –Габаритні розміри  реле LEG-12 

 

1.6  Компоновка друкованого вузла пристрою 

 

Компонування вузла друкованого при проектуванні радіоприладу - це 

процес розташування та підбору компонентів на платі з урахуванням 

електричних, механічних та термічних вимог. 

Основні етапи компонування вузла друкованого при проектуванні 

радіоприладу включають: 
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1. Аналіз вимог: Ретельний аналіз технічного завдання та вимог до 

пристрою. Це допомагає зрозуміти, які функції повинен виконувати 

радіоприлад і які параметри мають бути враховані під час вибору 

компонентів та розташування їх на платі. 

2. Вибір компонентів: Відбір електронних компонентів (резисторів, 

конденсаторів, транзисторів тощо), які відповідають вимогам щодо 

електричних характеристик, розмірів, якості і ціни. 

3. Розташування компонентів на платі: Розташування компонентів 

на платі відбувається з урахуванням електричних з'єднань між ними, 

мінімізації дротів і зближення важливих компонентів для скорочення 

довжини трас. Також важливо враховувати механічні аспекти, такі як 

забезпечення вільного доступу до компонентів для монтажу та 

обслуговування. 

4. Проектування трас: Прокладання доріжок (трас) для з'єднання 

компонентів. Важливо враховувати довжину трас, електромагнітну 

сумісність і перехідні опори. 

5. Валідація і аналіз: Перевірка правильності розташування 

компонентів і трас за допомогою спеціалізованих програмних засобів та 

симуляцій. Дана стадія може включати моделювання електричних 

характеристик і термічний аналіз. 

6. Оптимізація: Виправлення помилок та оптимізація компонування 

для поліпшення продуктивності, надійності і зменшення витрат. 

Компонування друкованої електронної апаратури (РЕА) двоканального 

термометра-термостата включає наступні етапи: 

Аналіз схеми: Після розробки електричної схеми пристрою 

проводиться аналіз для визначення оптимального розміщення компонентів на 

платі. 

Вибір плати: Обирається тип та розмір плати, який відповідає потребам 

проекту і забезпечує достатнє місце для розташування всіх компонентів. 
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Розміщення компонентів: Визначається оптимальне розташування 

компонентів на платі з урахуванням їх взаємозв'язку, електричних 

характеристик та теплових випромінювань. 

Маршрутизація шляхів: Визначаються шляхи з'єднання між 

компонентами на платі, забезпечуючи оптимальну електричну провідність і 

мінімальний перехідний опір. 

Урахування теплових аспектів: Під час компонування слід ураховувати 

теплові характеристики компонентів та забезпечувати достатню вентиляцію 

для відведення тепла. 

Врахування вимог щодо електромагнітної сумісності (EMC): При 

розташуванні компонентів слід дотримуватися вимог щодо мінімізації 

електромагнітних перешкод та інтерференції. 

Перевірка наявності дозволених зон: Перевіряється відповідність 

розміщення компонентів допустимим зонам на платі, щоб уникнути 

конфліктів та перекриття. 

Розміщення виводів: Виводи компонентів розташовуються таким 

чином, щоб забезпечити зручний доступ для підключення та обслуговування. 

Оптимізація маршрутів: Після розміщення компонентів проводиться 

оптимізація маршрутів з'єднань для мінімізації довжини шляхів та 

електричних втрат. 

Перевірка з погляду монтажу: Перевіряється можливість монтажу 

компонентів на плату з урахуванням технології виробництва та можливостей 

виробника. 

Також слід звернути увагу на такі аспекти та вимоги: 

1) Розміщення датчиків температури: Датчики температури, наприклад, 

DS1820, розташовуються на відстані один від одного, щоб забезпечити 

точність вимірювань і уникнути впливу навколишніх джерел тепла. 

2) Регулятори температури: Кожен регулятор температури повинен 

мати свою окрему секцію на платі, зручно розміщену поруч з відповідним 

датчиком температури.  
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Це дозволить забезпечити точність регулювання температури для 

кожного каналу. 

3) Мікроконтролер: Центральний мікроконтролер може бути 

розміщений по центру плати або у зручному місці для забезпечення легкого 

доступу до відповідних з'єднань та програмного забезпечення. 

4) Елементи живлення: Всі елементи живлення, такі як стабілізатори 

напруги або випрямлячі, можуть бути розміщені на одному краї плати, щоб 

забезпечити ефективну роботу всього пристрою. 

5) Інтерфейсні роз'єми: Роз'єми для зовнішніх пристроїв, таких як 

комп'ютери або інші периферійні пристрої, краще розміщувати на краю 

плати для легкого доступу та зручного підключення. 

6) Індикатори: LED-індикатори для візуального відображення стану 

кожного каналу можуть бути розташовані поруч з відповідними 

регуляторами або датчиками. 

7) Захистні елементи: Захисні елементи, такі як предохоронні діоди або 

фільтри, повинні бути розміщені на платі для захисту електронних 

компонентів від потенційних перешкод або спалахів. 

Важливо забезпечити оптимальне розташування компонентів на платі 

для забезпечення ефективної роботи пристрою та зручності обслуговування 

[21]. 
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1.7 Висновки до розділу 1   

 

Висновок до розділу 1 дослідження включає аналіз технічного 

завдання, структурної схеми виробу, опис принципу роботи електричної схеми 

та проектування вузлів пристрою. Визначено вимоги до пристрою, проведено 

аналіз його складових елементів та обрано компонентну базу. 
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2 Спеціальна частина 

 

2.1 Обгрунтування використання та вибору САПР для проектування     

 

Для розробки конструктиву друкованої плати використовується 

система автоматизованого проектування Altium Designer. Ця система 

застосовується для розробки односторонніх, двосторонніх та багатошарових 

плат на підприємствах, що займаються розробкою радіоелектронної 

апаратури, а також використовується радіоаматорами. 

У комплексному проєкті застосовується саме Altium Designer, оскільки 

ця програма ідеально підходить для розробки двосторонніх друкованих плат, 

а також для створення посадкових місць вручну або за допомогою майстра 

PCB Component Wizard, що дозволяє створювати деякі поширені посадкові 

місця на основі послідовного введення параметрів. Зручність та 

функціональність інтерфейсу програми дозволяють безперешкодно 

створювати схеми та друковані плати з подальшим їх експортом у 

виробництво, а також в інші програми (P-CAD, AutoCAD, Sprint Layout та 

інші). 

Для створення конструкторської документації використовується 

програма AutoCAD. Перевагами цієї системи автоматизованого проектування 

є можливість створення 3D моделі, з якої можна отримати робочі креслення; 

швидке отримання конструкторської та технологічної документації, 

необхідної для випуску виробу (складальних креслень, специфікацій, 

робочих креслень деталей); створення додаткових зображень виробу; 

уникнення ручних доробок. 

Створення елемента буде демонструватися на прикладі 

мікроконтролера AT24СО2-10РІ. 

Для початку створюється бібліотека компонентів. Для цього 

виконується команда File > New > Library > Schematic Library. Після 

створення бібліотека зберігається командою File > Save. 
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Для роботи з бібліотекою відкривається панель SCH Library, яку можна 

знайти у правому нижньому куті робочого вікна. Для створення нового 

елемента в бібліотеці натискається кнопка Add, після чого відкривається 

вікно для задання назви компонента. 

Далі необхідно встановити одиниці вимірювання координатної сітки 

робочого поля. Для цього вибирається команда Tools > Document Options, у 

вкладці Units ставиться галочка в полі Use Metric Unit System, а нижче 

вибираються міліметри. На рисунку 2.1 зображено одиниці вимірювання. 

 

Рисунок 2.1 – Вікно налаштування одиниць вимірювання 

 

Тепер, за допомогою кнопки у вигляді решітки над робочою областю та 

вибравши команду Set Snap Grid, задається крок сітки робочого поля, що 

вказується в нижній лівій частині вікна. Встановлюється крок сітки 0,5 мм. 

Починаємо створення елемента бібліотеки. Оскільки корпусом цього 

мікроконтролера є DIP-28, він повинен містити 28 виводів. Натискається 

клавіша P, вибирається команда Pin і починається розміщення виводу №1. 

Після цього вивід прикріплюється до курсору миші. Натисканням Tab 

відкривається вікно для встановлення його параметрів, як зображено на 

рисунку 2.2. У цьому вікні необхідно: в полі Length вказати значення 5 мм, 

що визначатиме довжину виводу; в полі Display Name і Designator вказати 

значення 1, що визначатиме ім’я та номер виводу відповідно, та поставити 

галочку в квадратику Visible у полі Designator, щоб номер виводу був 

видимий. 
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Рисунок 2.2 – Вікно налаштування вивода 

 

Аналогічні дії проводяться для виводів 2-14 включно, змінюються 

тільки цифри в полі Designator. Натискається клавіша P та вибирається 

команда Line, що дозволяє намалювати графіку корпусу мікроконтролера. 

Наступним етапом є встановлення виводів №15-28 з іншого боку 

мікроконтролера. Всі дії з ними аналогічні діям попередніх виводів, проте 

нумерація виводів йде знизу вверх. 

Після цього компонент зберігається, виконавши команду File > Save. 

На рисунку 2.3 зображено готове символьне позначення мікроконтролера. 

 

Рисунок 2.3 – Символьне позначення мікроконтролера 
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Тепер для цього компонента потрібно створити посадкове місце. Для 

цього виконується команда File > New > Library > PCB Library. У дереві 

проєкту з’являється нова бібліотека. Після створення її зберігають, 

натиснувши File > Save. 

Як і в попередньому випадку, для роботи з цією бібліотекою потрібна 

спеціальна панель під назвою PCB Library, яку можна знайти у правому 

нижньому куті робочого вікна. 

Починається з встановлення одиниць вимірювання – міліметри. Для 

цього виконується команда Tools > Library Options та у полі Unit вибирається 

Metric. На рисунку 2.4 зображене вікно налаштування кроку сітки. 

 

Рисунок 2.4 – Вікно налаштування кроку сітки 

 

Встановлюється крок сітки. Натискається клавіша G, і біля курсору 

з'являється список кроків сітки. Вибирається 0,5 мм та збільшується масштаб 

робочого поля. 

Створюється новий компонент, для цього натискається ПКМ і 

вибирається New Blank Component. В результаті з'являється новий запис 

компонента, якому задається ім'я. 
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Для встановлення контактних площадок виконується команда Place > 

Pad, і натискається клавіша Tab для встановлення її параметрів. Потрібно 

задати параметри контактної площадки в полі Size and Shape та вибрати 

форму площадки в цьому ж полі. Нумерацію контактних площадок слід 

починати з одиниці, оскільки тут вказуються номери фізичних виводів. На 

рисунку 2.5 показано встановлені параметри контактної площадки. 

 

Рисунок 2.5 – Вікно встановлення параметрів контактної площадки 

 

Другим етапом створення посадкового місця є розробка графіки, яка 

повинна бути виконана в шарі Top Overlay. Вибрати шар можна в нижній 

частині вікна програми. Тепер у цьому шарі створюється контур компонента 

за допомогою команди Place > Line. На рисунку 2.6 показано готове 

посадкове місце мікроконтролера. 

 

Рисунок 2.6 – Готове посадочне місце мікроконтролера 
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Останнім етапом роботи є встановлення посилання для компонента на 

модель посадкового місця. Для цього необхідно створити інтегровану 

бібліотеку. Виконується команда File > New > Project > Integrated Library, 

після чого в структурі панелі Project з'являється новий документ, який 

потрібно зберегти, натиснувши на нього правою кнопкою миші та вибравши 

команду Save Project. 

Тепер необхідно додати до структури створеного проєкту раніше 

створені бібліотеки, перемістивши їх у дереві панелі. 

Коли всі необхідні бібліотеки знаходяться в структурі інтегрованої 

бібліотеки, можна підключити моделі до відповідних компонентів. Потрібно 

відкрити бібліотеку символів і натиснути кнопку Add Footprint у вікні 

підключення моделей. На рисунку 2.7 показано підключення посадкового 

місця. 

 

 

Рисунок 2.7 – Підключення посадочного місця 

2.2 Опис створення 3D  плати виробу  

3D  модель  друкованої  плати зображена  на  рисунку  2.8 та рисунку 2.9 

[24]. 
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Рисунок 2.8-3D вигляд плати друкованої з сторони елементів 

Вигляд плати друкованої з вигляду пайки і елементів. Плата 

двостороння та виготовлена комбінованим методом. 

 

Рисунок 2.9-3D вигляд плати друкованої з сторони пайки 
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2.3 Висновки до розділу 2 

 

Вибір і використання комп'ютерної системи автоматизованого 

проектування (САПР) для розробки має під собою обґрунтовану базу, що 

ґрунтується на її здатності забезпечити точність та ефективність 

проектування, особливо у контексті роботи з складними електронними 

системами та потреб інтеграції з іншими інженерними інструментами. 

Створення тривимірної моделі плати виробу виконується через 

послідовне виконання етапів у вибраній САПР. Цей процес охоплює 

створення схеми, розміщення компонентів, маршрутизацію слідів та 

підтвердження правильності проекту через верифікацію. Такий підхід 

дозволяє забезпечити якість та ефективність у розробці електронних виробів. 
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3. Безпека життєдіяльності та охорона праці. 

3.1 Види небезпек та поняття потенційної небезпеки 

 

Людська діяльність має багатогранні форми, і де б вона не проявлялась 

в тій чи іншій мірі супроводжується небезпекою, яка може призводити до 

негативних наслідків. Тому є всі підстави стверджувати, що будь – яка 

діяльність потенційно небезпечна. 

Небезпека – це негативна властивість матерії, яка здатна завдати шкоди 

певним елементам Всесвіту. 

Небезпека для людини – це явище процеси або вплив на людину 

несприятливих чи навіть несумісних з життям чинників. 

При ідентифікації небезпек необхідно виходити з принципу “все 

впливає на все”, тобто джерелом небезпеки може бути все живе, а підлягати 

небезпеці також може все живе і неживе. 

Ідентифікація – це процес виявлення та встановлення кількісних, 

часових та просторових характеристик небезпек. 

В процесі ідентифікації виявляються: 

  - ймовірність прояву небезпек; 

    - просторова локалізація (координати); 

  - можливі матеріальні збитки. 

 Небезпеки існують і відбуваються в будь – яких сферах предметної 

діяльності і не діють вибірково, а виникнувши, вони впливають на все 

матеріальне довкілля. 

Номенклатура, тобто перелік назв небезпек, систематизованих за 

окремими ознаками 

Номенклатура налічує понад 150 найменувань. З метою аналізу, 

узагальнення виникла необхідність класифікації небезпек. 

Класифікація – розподіл можливих будь – яких об’єктів (елементів) на 

групи. 
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          Існують різні системи класифікації небезпек. 

 За джерелом походження небезпеки бувають: природні, 

техногенні,        соціально – політичні та комбіновані. 

 За локалізацією небезпеки бувають пов’язані з літосферою, 

гідросферою, атмосферою або з космосом. 

 За часом проявлення негативних наслідків небезпеки поділяються 

на імпульсивні та кумулятивні. 

 По сфері проявлення небезпеки розрізняються як побутові, 

дорожньо – транспортні, виробничі, спортивні. 

 За завданою шкодою небезпеки бувають соціальними, 

технічними, екологічними, груповими, індивідуальними. 

 За  наслідками негативного впливу небезпеки можуть призводити 

до травм, захворювань, пожежі аварій і ін. 

 За характером дії на людину небезпеки поділяються на активні та 

пасивні. До пасивних небезпек відносяться ті небезпеки, що активізуються за 

рахунок енергії, носієм якої є людина. Це можуть бути гострі нерухомі 

елементи, нерівні поверхні, по яких рухаються люди. 

  Джерела небезпеки та їх класифікація. 

За джерелом походження небезпеки поділяються на 4 групи на 

міжнаціональному, етнічному, расовому чи релігійному ґрунті. 

          1)  Природні небезпеки – природні об’єкти, явища природи та стихійні 

лиха, які можуть завдати шкоду людині або ж становлять загрозу для її життя 

чи здоров’я; сонячне та космічне випромінювання, небезпечні рослини. 

2) Техногенні небезпеки – передусім небезпеки пов’язані з 

використанням транспортних засобів, з  експлуатацією обладнання, 

використанням горючих, і вибухонебезпечних речовин та матеріалів, з 

використанням електричної енергії, хімічних речовин, різних видів 

випромінювання(іонізуючого, електромагнітного, акустичного). 
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 3) Соціально-політичні небезпеки – це ті небезпеки, які відбуваються в 

соціальному середовищі. 

До соціальних джерел небезпек  відносяться небезпеки, викликані 

низьким духовним та культурним рівнем, бродяжництво, проституція, 

пияцтво, алкоголізм тощо. Джерелами цих небезпек є незадовільний 

матеріальний стан, погані умови проживання, страйки, повстання, революції, 

конфліктні ситуації 

Джерелами політичних небезпек є конфлікти на міжнаціональному та 

міждержавному рівнях, духовне гноблення, політичний тероризм, 

ідеологічні, між партійні, міжконфесійність та збройні конфлікти, війни. 

Незважаючи на велику кількість природних, техногенних та соціально 

– політичних небезпек, все ж таки найбільшу кількість їх у наш час 

становлять комбіновані – природно – техногенні, природно – соціальні та 

соціально – техногенні небезпеки. 

4) Комбіновані небезпеки – це ті небезпеки, які виникають в наслідок 

антропогенної діяльності людини. 

Природно – техногенні небезпеки: смог, кислотні дощі, пилові бурі, 

зменшення родючості ґрунтів, виникнення пустель та інші явища, до яких 

призвела людська діяльність. 

Природно – соціальні небезпеки: химерні етноси, наркоманія, епідемії 

інфекційних захворювань, венеричні захворювання, СНІД. 

Соціально – техногенні небезпеки: професійна захворюваність, 

професійний травматизм, психічні відхилення та захворювання, викликані 

виробничою діяльністю, масові психічні відхилення та захворювання, 

викликані впливом на свідомість і підсвідомість засобами масової інформації 

та спеціальними засобами, токсикоманія. 

Слід чітко усвідомлювати, що наявність джерела небезпеки ще не 

означає того, що людині чи групі людей обов’язково повинна бути завдана 

якась шкода чи пошкодження. 
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 Наявність джерела небезпеки свідчить передусім про існування або ж 

можливість утворення конкретної небезпечної ситуації, за якої буде завдана 

шкода. До матеріальних збитків, пошкодження, шкоди здоров’ю, смерті або 

іншої біди призводить конкретний вражаючий фактор. 

Під вражаючими факторами розуміють такі чинники життєвого 

середовища, які за певних умов завдають шкоди як людям так і системам їх 

життєзабезпечення, призводять до матеріальних збитків. 

Залежно від наслідків дії конкретних вражаючих факторів на організм 

людини вони в деяких випадках (наприклад в охороні праці) поділяються на 

шкідливі та небезпечні. 

До шкідливих факторів відносять такі чинники, дія яких в певних 

умовах може спричинити захворювання або зниження працездатності 

(поновлюється після відпочинку). 

До небезпечних факторів відносять такі чинники, дія яких в певних 

умовах призводить до травматичного ушкодження тканин чи органів 

організму людини 

Необхідно знати, що між небезпечними та шкідливими чинниками не 

існує принципової різниці. Залежно від часу дії та рівня шкідливі чинники 

можуть бути небезпечними. 

Певними ознаками небезпечних  та шкідливих чинників є: 

 Безпосередня негативна дія на організм людини; 

 Труднощі для нормального функціонування людини; 

 Перевищення межі експлуатаційної надійності технічних 

пристроїв. 

Небезпечні та шкідливі фактори поділяються на фізичні,хімічні, 

біологічні, психофізіологічні. 

 

 



 

Змн. Арк. № докум. Підпис Дата 

Арк. 

 
 

ЗВА3.22.056.001 ПЗ 
 
 

Фізичні (рухомі машини, механізми, заготівки, конструкції, що можуть 

руйнуватися; ґрунти, що обвалюються, запиленість і загазованість повітря 

робочої зони, підвищена або понижена температура матеріалів та робочої  

зони, шуми, вібрації та ін.). 

Хімічні (кислоти, лікувальні препарати, гази, пестициди, мінеральні 

добрива та інші хімічні речовини, дезінфекційні засоби). 

Біологічні (бактерії, віруси, отруйні комахи, змії, дикі і свійські 

тварини). 

Психофізіологічні за характером поділяють на фізичні перевантаження 

(статичні і динамічні) і нервово-психічні – розумові перевантаження 

(монотонність праці, емоційні стреси). 

Небезпечні і шкідливі фактори дуже часто бувають прихованими і 

проявляються в умовах, які важко передбачити. Слід також знати, що одне 

джерело небезпеки може призводити до різного роду небезпечних ситуацій, а 

останні породжують різні негативні наслідки. 

Джерелом небезпеки являються транспортні засоби ( автомобілі …) 

Небезпечна ситуація – це природні умови, керування в нетверезому 

стані, порушення правил дорожнього руху, несправність автомобіля. 

Негативні наслідки – це зіткнення, наїзд на людину, пошкодження 

транспортного засобу 

Для того щоб виникла реальна небезпечна ситуація, необхідна причина 

або умова, при якому потенційна небезпека переходить у реальну. Логічним 

процесом розвитку небезпеки є тріада: ”джерела небезпеки – причина –

 негативні наслідки” 

 

3.2 Класифікація механічних небезпек та їх вплив на організм людини 

 

Підстерігати небезпека у вигляді різних негативних факторів нас може 

практично скрізь. Навіть на самих нешкідливих робочих місцях можна 

говорити про шкідливий вплив комп’ютерів, тривалої сидячої роботи і про 
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багато іншого. Але в цій статті хотілося б торкнутися шкідливі виробничі 

фактори, з якими люди стикаються на підприємствах. 

На багатьох заводах і фабриках виробництво пов’язане з постійним 

впливом на працівників несприятливих умов. Шкідливі та небезпечні 

виробничі фактори нерозривно пов’язані між собою. ВПФ — це ті фактори, 

які в результаті свого тривалого або короткочасного впливу на людину 

призводять до погіршення стану його здоров’я або до травми. На 

виробництвах з такими умовами праці різні нещасні випадки відбуваються 

досить часто. 

ВПФ — це фактори, які, діючи на працівника, знижують його 

працездатність або призводять до різних захворювань, їх часто ще називають 

професійними хворобами. Варто зазначити, що межа між цими двома 

групами факторів досить умовна. При деяких умовах шкідливі виробничі 

фактори можуть стати небезпечними. Наприклад, підвищена вологість 

відноситься до несприятливих умов праці, вона може викликати різні 

захворювання дихальної системи. Якщо людині доводиться в таких умовах 

працювати з електричним струмом, то це стає вже занадто небезпечно, а не 

просто шкідливо. 

Класифікація шкідливих виробничих факторів 

Всі фактори на будь-якому підприємстві можуть мати різне 

походження. Часто можна стикатися з несприятливими умовами праці, які 

виникають з вини керівництва. Це питання потребує особливої уваги з боку 

перевіряючих органів. Хочеться сподіватися, що велика частина небезпечних 

факторів має природне походження, і людині просто необхідно вжити всі 

заходи, щоб їх вплив був мінімальним. Всі шкідливі виробничі фактори 

ГОСТ поділяє на наступні групи: 

 Фізичні. 

 Хімічні. 

 Біологічні. 
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 Психофізіологічні, до яких можна віднести важкі та напружені 

умови праці. 

Можна відзначити, що немає чіткої межі між шкідливими та 

небезпечними факторами, вона завжди умовна і в будь-який момент може 

бути зруйнована. 

Джерела шкідливих хімічних факторів 

На виробництві завжди є технологічні процеси, обладнання, які є 

джерелом виділення ВПФ. До цих проваджень можна віднести: 

 Очищення деталей за допомогою хімічних засобів. 

 Фарбування устаткування. 

 Зварювальні роботи. 

 Процеси нанесення захисних антикорозійних покриттів. 

 Обробку або переробку металів. 

При здійсненні всіх цих процесів виділення шкідливих речовин 

неминуче, але, як правило, посилене їх утворення пов’язане з недотриманням 

технологій або невмілим їх використанням. 

Фізичні фактори 

На багатьох виробництвах просто неможливо уникнути впливу деяких 

факторів. Серед них особливе місце займають: 

 Температура, висока вологість і випромінювання. 

 Електромагнітні поля. 

 Лазерне і ультразвукове випромінювання. 

 Вібрація. 

 Сильний шум. 

 Освітлення, яке може бути як занадто інтенсивним, так і 

недостатнім, що однаково шкідливо для зору. 

 Вплив пилу і аерозолів. 

 Заряджений повітря. 

 Працюючі частини обладнання. 
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Кожен фактор окремо начебто і не становить особливої небезпеки для 

здоров’я людини при короткочасному впливі. Але часто працівник перебуває 

тривалий час у їх оточенні, та ще відразу декількох, тому їх вплив стає 

цілком відчутним. 

На підприємствах, де в цехах стоять верстати та інше обладнання, без 

шуму, як правило, не обходиться. Постійно працює техніка видає гучні 

звуки, які можуть змінювати свою інтенсивність. Якщо людина змушений 

регулярно зазнавати такого впливу, то це негативно позначиться на його 

здоров’ї. Від сильного шуму починає боліти голова, підвищується тиск, 

знижується гострота слуху. Зрештою, від таких умов знижується 

працездатність, з’являється втома, знижується увага, а це вже може 

призвести до нещасного випадку. Керівники на подібних підприємствах 

повинні подбати про своїх працівників, щоб постаратися хоч трохи зменшити 

негативний вплив шуму на організм. Для цього можна використовувати: 

 Глушники шуму. 

 Індивідуальні засоби захисту, наприклад навушники, беруші, 

шоломи. 

 Виробляти звукоізоляцію галасливих місць з допомогою 

використання захисних кожухів, обладнання кабінок. 

 Оздоблення приміщень звукопоглинаючими матеріалами. 

Ці заходи допоможуть створити більш сприятливу обстановку для 

працівників. 

Вплив вібрації та її усунення 

Вібрація входить в перелік шкідливих виробничих факторів. Її можна 

класифікувати по декількох категоріях: 

 За способом передачі: загальна і локальна. 

 По своєму напрямку: вертикальна і горизонтальна. 

 По часу дії: тимчасова і постійна. 
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В результаті постійного впливу даного фактора починає страждати не 

тільки нервова система, а й опорно-рухова, і система аналізаторів. Робітники, 

які змушені працювати в таких умовах, часто скаржаться на головні болі, 

запаморочення, заколисування. 

Якщо додати ще і вплив супутніх чинників, таких як вологість, висока 

температура, шум, то це тільки посилює шкідливий вплив вібрації. Для 

захисту від неї можна запропонувати наступні заходи: 

 Заміна обладнання на більш технологічне. 

 Використання м’яких покриттів на вібруючих частинах приладів 

або устаткування. 

 Установка агрегатів на грунтовний фундамент. 

Хімічні фактори 

Речовини з цієї групи можна розрізняти за наступним категоріям: 

1. За своїм впливом на організм людини шкідливі та небезпечні 

виробничі фактори хімічної природи поділяються на: 

o Токсичні. Діють негативно на весь організм, наприклад чадний 

газ, ртуть, свинець. 

o Дратівливі. Такі речовини, як ацетон, хлор, оксиди азоту 

викликають подразнення слизових оболонок. 

o Канцерогенні. Оксиди хрому, берилій зі своїми з’єднаннями 

можуть призводити до розвитку ракових клітин. 

o Викликають алергічні реакції. 

o Мутагенні. Провокують зміни на рівні ДНК клітини. 

o Впливають на репродуктивну функцію. 

2. За способом надходження в організм: 

o Через дихальну систему. 

o Через ШКТ. 

o Через шкіру та слизові оболонки. 
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Також дані шкідливі фактори виробничого середовища впливають 

різною мірою, залежно від чого серед них виділяють: 

 Надзвичайно небезпечні. 

 Небезпечні високою мірою. 

 Помірно небезпечні. 

 Малонебезпечні. 

Якщо на шкідливих підприємствах досить ефективно налагоджено 

використання засобів захисту, то робітники будуть піддаватися впливу 

небезпечних речовин в набагато меншому ступені. 

Фактори трудового процесу 

До психофізіологічних факторів можна віднести тягар умов праці і 

його напруженість. Коли мова йде про важку працю, то мається на увазі: 

 Велике навантаження на опорно-рухову, серцево-судинну, 

дихальну системи. 

 Величина статичного навантаження. 

 Число однакових рухів. 

 Величина вантажів, які доводиться піднімати. 

 Поза робітника під час виконання процесу. 

Під напруженістю роботи мається на увазі навантаження на нервову 

систему, органи почуттів (більше аналізатори). Сюди можна віднести 

тривалу розумову роботу, монотонність виконуваних процесів, емоційні 

перевантаження. Все це шкідливі виробничі фактори, які, якщо розібратися, 

практично кожен з нас на своєму робочому місці відчуває в тій чи іншій мірі. 

 

3.3 Висновки до розділу 3 

 

В розділі 3 було розглянуто види небезпек та поняття потенційної 

небезпеки, а також класифікацію механічних небезпек та їх вплив на 

організм людини. Небезпеки можуть бути різноманітними за природою 

загрози, включаючи механічні, хімічні, біологічні та інші. Потенційна 
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небезпека визначає ступінь можливості небезпеки перетворитися на реальну 

загрозу. Механічні небезпеки включають удари, тиск, розтягнення та інші, і 

можуть мати різний вплив на організм людини, від легких травм до 

смертельних ушкоджень. 
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Висновки 

 

У процесі виконання кваліфікаційної роботи було проведено всебічний 

аналіз технічного завдання та структурної схеми розроблюваного виробу. 

Описано принцип роботи електричної принципової схеми та виконано її 

детальний аналіз. На основі проведених досліджень здійснено проектування і 

розрахунок вузлів схеми, включаючи розрахунок електричних параметрів 

окремих каскадів та параметрів друкованого монтажу. 

Вибір компонентної бази здійснено на підставі детального 

обґрунтування, що забезпечило оптимальне поєднання надійності та вартості 

компонентів. Компоновка друкованого вузла пристрою була розроблена з 

урахуванням усіх технічних вимог, що дозволило досягти високої якості 

монтажу і функціональності. 

Спеціальна частина роботи була присвячена обґрунтуванню 

використання систем автоматизованого проектування (САПР) для розробки 

даного пристрою. Описано процес створення 3D-моделі плати виробу, що 

дозволило візуалізувати конструктивні особливості та здійснити точну 

перевірку проектних рішень. 

Особлива увага була приділена питанням охорони праці та безпеки 

життєдіяльності. Розроблені рекомендації забезпечують безпечну 

експлуатацію пристрою та захист здоров'я користувачів. 

Загалом, результати виконаної роботи підтверджують правильність 

обраних методів та підходів до проектування електронного пристрою, а 

також його технічну та економічну ефективність. 
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